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KD2 Pro 1 INTRODUCTION

1 Introduction

Welcome to your new KD2 Pro Thermal Properties Analyzer man-
ufactured by Decagon Devices Inc. This guide should help you un-
derstand and use your instrument to the best of its capability.

1.1 About the KD2 Pro

The KD2 Pro is a handheld device used to measure thermal proper-
ties. The base KD-2 Pro package consists of a handheld controller
and one sensor kit of your choice. There are several sensors available
for purchase that operators can insert into almost any material. The
single needle sensors measure thermal conductivity and resistivity;
while the dual-needle sensor measures thermal conductivity, resistiv-
ity, volumetric specific heat capacity and diffusivity. Please read this
manual to efficiently and effectively use your KD2 Pro for thermal
properties measurements.

1.2 Shipping Contents

KD2 Pro Controller

Carrying Case

USB-to-Serial Cable (3 ft)

“AA” Alkaline Batteries (Four)

Operator’s Manual

KD2 Pro “Read Me First”

Sensor Kit(s) One or more of the sensor kits listed in Table 1.
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1 INTRODUCTION KD2 Pro

Table 1: Available Sensor Kits

SH-1 Sensor
Kit

RK-1 Sensor
Kit

TR-1 Sensor
Kit

KS-1 Sensor
Kit

SH-1 Dual
Needle Sensor

RK-1 Single
Needle Sensor

TR-1 Single
Needle Sensor

KS-1 Single
Needle Sensor

SH-1
Verification
Standard

RK-1
Verification
Standard

TR-1
Verification
Standard

Glycerin
Verification
Standard

Certificate of
Quality
Assurance

Certificate of
Quality
Assurance

Certificate of
Quality
Assurance

Certificate of
Quality
Assurance

Dual Needle
Spacer

Arctic
Alumina
Thermal
Grease

Arctic
Alumina
Thermal
Grease

Replacement
Lid Septums

SDS Arctic
Alumina

SDS Arctic
Alumina

SDS Glycerin

5/32
Roto-Hammer
Drill Bits

2.40 mm Drill
Bits

RK-1 Quick
Start

Concrete Pilot
Pins

Note: You can configure your KD2-Pro with one or a combination
of the sensors listed in Table 1.

1.3 Customer Support

If you ever need assistance with your device, have any questions or
feedback, there are several ways to contact us. Decagon has Cus-
tomer Service Representatives available to speak with you Monday
through Friday, between 7am and 5pm Pacific time.

Note: If you purchased your sensor through a distributor, please con-
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KD2 Pro 1 INTRODUCTION

tact them for assistance.

Email:
support@decagon.com or sales@decagon.com

Phone:
509-332-5599

Fax:
509-332-5158

If contacting us by email or fax, please include as part of your mes-
sage your instrument serial number, your name, address, phone, fax
number, and a description of your problem or question.

1.4 Warranty Information

The KD2 Pro has a 30-day satisfaction guarantee and a one-year
warranty.

1.5 Seller’s Liability

Seller warrants new equipment of its own manufacture against de-
fective workmanship and materials for a period of one year from the
date of receipt of equipment.

Note: We do not consider the results of ordinary wear and tear,
neglect, misuse, or accident as defects.

The Seller’s liability for defective parts shall in no event exceed the
furnishing of replacement parts “freight on board” the factory where
originally manufactured. Material and equipment covered hereby
which is not manufactured by Seller shall be covered only by the
warranty of its manufacturer. Seller shall not be liable to Buyer for
loss, damage or injuries to persons (including death), or to property
or things of whatsoever kind (including, but not without limitation,
loss of anticipated profits), occasioned by or arising out of the instal-
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1 INTRODUCTION KD2 Pro

lation, operation, use, misuse, nonuse, repair, or replacement of said
material and equipment, or out of the use of any method or process
for which the same may be employed. The use of this equipment con-
stitutes Buyer’s acceptance of the terms set forth in this warranty.
There are no understandings, representations, or warranties of any
kind, express, implied, statutory or otherwise (including, but with-
out limitation, the implied warranties of merchantability and fitness
for a particular purpose), not expressly set forth herein.
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2 KD2 Pro Overview

The KD2 Pro is a battery-operated, menu-driven device that mea-
sures thermal conductivity and resistivity, volumetric specific heat
capacity and thermal diffusivity. We designed the KD2 Pro for ease
of use and maximum functionality.

2.1 Specifications

Operating Environment

Controller: 0 to 50 ◦C

Sensors: −50 to +150 ◦C

Controller

Power: 4 AA batteries

Battery Life: At least 500 readings in constant use or three years
with no use (battery drain in sleep mode < 50 uA)

Case Size: 15.5 cm x 9.5 cm x 3.5 cm

Display: 3 cm x 6 cm, 128 x 64 pixel graphics LCD

Keypad: 6 key, sealed membrane

Data Storage: 4,095 measurements in flash memory (both raw and
processed data are stored for download)

Interface: 9-pin serial

Read Modes: Manual and Auto Read

Sensors

6 cm (small) single needle (KS-1)

Size: 1.3 mm diameter x 6 cm long

Range:

0.02 to 2.00 W
(m∗K) (thermal conductivity)

50 to 5000 ◦C ∗ cm
W (thermal resistivity)
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2 KD2 PRO OVERVIEW KD2 Pro

Accuracy:

(Conductivity): ±5% from 0.2 to 2 W
(m∗K) ±0.01 W

(m∗K)

from 0.02 to 0.2 W
(m∗K)

Cable length: 0.8 m

10 cm (large) single needle (TR-1)

Size: 2.4 mm diameter x 10 cm long

Range:

0.1 to 4.0 W
(m∗K) (thermal conductivity)

25 to 1000 ◦C ∗ cm
W (thermal resistivity)

Accuracy:

(Conductivity): ±10% from 0.2 to 4.0 W
(m∗K)

±0.02 W
(m∗K) from 0.1 to 0.2 W

(m∗K)

Cable length: 0.8 m

3 cm dual-needle (SH-1)

Size: 1.3 mm diameter x 3 cm long, 6 mm spacing

Range:

0.02 to 2.00 W
(m∗K) (thermal conductivity)

50 to 5,000 ◦C ∗ cm
W (thermal resistivity)

0.1 to 1.0 mm2

s (diffusivity)
0.5 to 4.0 mJ

(m3K)
(volumetric specific heat)

Accuracy:

(Conductivity) ± 10% from 0.2 to 2 W
(m∗K)

± 0.01 W
(m∗K) from 0.02 to 0.20 W

(m∗K)

(Diffusivity) ±10% at conductivities above 0.1 W
(m∗K)

(Volumetric Specific Heat) ±10% at conductivities above
0.1 W

(m∗K)

Cable length: 0.8 m
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6 cm (thick) single needle (RK-1)

Note: The RK-1 is available for purchase and is not included
with standard KD2 Pro.

Size: 3.9 mm diameter x 6 cm long

Range:

0.10 to 6.00 W
(m∗K) (thermal conductivity)

17 to 1000 ◦C * cm
W (thermal resistivity)

Accuracy (Conductivity):

±10% from 0.2 to 6.0 W
(m∗K)

0.02 W
(m∗K) from 0.1 to 0.2 W

(m∗K)

Cable length: 0.8 m
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2.2 Keypad Operation

Figure 1: KD2 Pro KeyPad
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Power: Activates and deactivates the KD2 Pro.

Note: The device automatically turns off if not
used for more than ten minutes, except while
running in Auto Mode.

Menu: Cycles between the four menus at the
top of the screen.

Note: Pressing Menu while changing a setting
cancels any operations.

Arrow Keys: Navigate within menus, sub-
menus, and modifies numerical values in sub-
menus, as well as selecting different units. Hold-
ing down an arrow key allows you to scroll be-
tween different options quickly.

Escape: Backs out of sub-menus and cancels
certain actions.

Enter: Makes selections within menus, sub-
menus, and also begins taking measurements.

2.3 Choosing a Sensor

The KD2 Pro comes with three separate sensors designed for mea-
surements in specific sample types, the KS-1, TR-1, and SH-1. The
RK-1 is also available for purchase with your KD2 Pro.

KS-1

The small (6 cm long, 1.3 mm diameter) single needle KS-1 sen-
sor measures thermal conductivity and thermal resistivity. We de-
signed the KS-1 for liquid samples and insulating materials (thermal
conductivity < 0.1W ( W

m∗K )). The KS-1 sensor applies a very small
amount of heat to the needle which helps to prevent free convection
in liquid samples (see Section 5 in this manual regarding measure-

9
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ment in liquid samples for more information). However, the small
size of the needle and typically short heating time make the KS-1
a poor choice for granular samples such as soil and powders where
contact resistance can be an important source of error. In insulating
materials, the errors from contact resistance become negligible mak-
ing the KS-1 sensor a good choice.

TR-1

The large (10 cm long, 2.4 mm diameter) single needle TR-1 sensor
measures thermal conductivity and thermal resistivity. We designed
the TR-1 primarily for soil, and other granular or porous materi-
als. You can either insert the pilot pin or drill an appropriate sized
hole for the TR-1 sensor. The relatively large diameter and typically
longer heating time of the TR-1 sensor minimize errors from contact
resistance in granular samples or solid samples with pilot holes. The
TR-1 needle heats the sample significantly more than the KS-1 sen-
sor, which allows it to measure higher thermal conductivity samples
(see earlier specifications). Customers should not measure low vis-
cosity liquid samples with the TR-1 sensor. The 2.4 mm diameter
of the TR-1 makes it more robust than the KS-1, meaning that it
is less likely to be damaged by normal usage conditions in soil or
other solid materials. Additionally, the dimensions of the TR-1 sen-
sor conform to the specifications for the Lab Probe called out by the
IEEE 442, “Guide for Soil Thermal Resistivity Measurements,” and
ASTM 5334, “Standard Test Method for Determination of Thermal
Conductivity of Soiled and Soft Rock by Thermal Needle Probe Pro-
cedure.”

Note: Despite its durability, the TR-1 is a hollow needle that bends
with enough applied force. Although the TR-1 comes with drill bits
for pilot holes, drilling straight holes in solid materials like rock and
concere is very difficult. Consider using the RK-1 for applications
involving solid rock and concrete.

SH-1

The dual needle SH-1 sensor measures volumetric heat capacity, ther-

10



KD2 Pro 2 KD2 PRO OVERVIEW

mal diffusivity, thermal conductivity, and thermal resistivity. The
SH-1 is compatible with most solid and granular materials, but op-
erator’s should not use it in liquids due to the large heat pulse and
resulting free convection in liquid samples. It is a good fit for foods
due to its smaller size.
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RK-1

Note: The RK-1 is optional and not included with the standard KD2
Pro

The thick (6 cm long, 3.9 mm diameter) single needle RK-1 sensor
measures thermal conductivity and thermal resistivity. We designed
the RK-1 specifically for use in hard materials like rock or cured
concrete, where you must use a rotary hammer to drill a hole to ac-
commodate the sensor. The TR-1 sensor is generally more accurate
than the RK-1 sensor and is the preferred choice in granular and
solid materials as long as you can make a hole to accommodate the
longer and thinner sensor. In instances where the material is too
hard to drill a hole for the long, thin TR-1 sensor, a 5

32 or 4 mm
rotary hammer bit (included in the RK-1 kit) can be used to drill
a pilot hole in the material. Make sure to remove any dust or drill
cuttings from the rotary hammer hole using a swab or compressed
air before inserting the RK-1 sensor. It is also necessary to use the
included thermal grease to ensure good thermal contact between the
RK-1 sensor and the test material.

Note: Do not use the RK-1 sensor in liquid samples.

Read Time

The read time is the time, in minutes, the KD2 Pro takes to gather
data for computing thermal properties. It applies heat to the sensor
for half of the set time, and takes measurements over the full time.
The KD2 Pro waits thirty seconds for temperature equilibration be-
fore heating starts, so the entire measurement time should be the
“Read Time” plus 30 seconds. The sensor takes sixty temperature
readings during the read time, so the number entered here also de-
termines the number of seconds between temperature readings. This
number displays in the upper right corner of the screen and is avail-
able with each data record after downloading. Default read times
are one minute for the KS-1 sensor, two minutes for the SH-1 sensor,
five minutes for the TR-1 sensor, and ten minutes for the (optional)
RK-1 Sensor.
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The longer read times for the TR-1 and RK-1 sensors help to prevent
errors caused by effects from the large diameter needle and contact
resistance between the sensor and the sample in granular and solid
materials.

The shorter read time for the KS-1 sensor reduces the amount of
heat input into the sample. This is especially important with liquid
samples where excessive sample heating can cause errors from free
convection (Section 5.4) In low viscosity samples (e.g. water and
aqueous solutions), configure the KS-1 read time should be config-
ured to the minimum allowed one minute.

To set the read time, press menu and navigate to the Config menu.
Scroll down to Read Time and press Enter. Arrow down to the sen-
sor that you want and press Enter. Then press Enter again to scroll
through the read times for that sensor.

13
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2.4 KD2 Pro Sensor Compatibility

Table 2: Sensor Use Guide

Sample Material KS-1 TR-1 SH-1 RK-1

Low viscosity Liquids
BEST1 NO NO NO

(Water)

High Viscosity Liquids
BEST2 OK2 NO NO

(glycerol, oil)

Insulation and Insulating
BEST3 NO NO NO

Materials

Moist Soil NO BEST OK OK

Dry Soil, Powders, and
NO BEST4 OK OK

Granual Materials

Concrete and Rock NO BEST5,7 OK6 BEST7

Other Solids NO BEST5 OK OK

Volumetric Specific Heat NO NO BEST NO

Thermal Diffusivity NO NO BEST NO

1In low viscosity liquids, set the read time to the minimum allowed one minute
and only operate in low power mode to avoid free convection.

2In high viscosity liquids, only use the KS-1 or TR-1 in low power mode.
3The KS-1 in default mode (low power, 1 min read).
4In dry granular materials where contact resistance can be significant, extend

the read time to the maximum allowed ten minutes to produce the most accurate
results.

5In solid materials where a pilot hole has been drilled and contact resistance
can be significant, use thermal grease and extend the read time to the maximum
allowed ten minutes to produce the most accurate results.

6The SH-1 sensor takes accurate measurements in rock and cured concrete,
but it is very difficult to drill small diameter, parallel holes in these materials to
accommodate the SH-1 needles.

7The TR-1 is generally more accurate than the RK-1 sensor and should be
used if possible. However, it is extremely difficult (or impossible) to drill a long,
thin hole into cured concrete and rock samples to accommodate the TR-1. The
TR-1 also comes with pilot pins for use in wet concrete or fluidized backfill.
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Power Mode

You can configure the KD2 Pro to measure each of the three sen-
sor types in either high power mode or low power mode. In high
power mode, the KD2 Pro applies a relatively large heating current
to the sensor during a measurement resulting in greater sensor heat-
ing. In low power mode, the KD2 Pro applies a small current to
the sensor resulting in less heating of the sensor. The KS-1 sensor
defaults to low power mode, while the TR-1, SH-1, and RK-1 needles
all default to high power mode.

We recommend that only expert operators change the power mode
from the default settings for special measurements. In all but a few
cases, changing the power mode from the default settings results in
reduced accuracy.Feel free to contact Decagon to discuss your specific
measurements before changing from the default power mode setting.
Pay attention to the following cautions when operating your KD2
Pro.

Caution: Do not attempt to make measurements in liquids
with the KS-1 or TR-1 in high power mode. The additional
heating from the higher heat input causes free convection
and compromise the measurement.

Caution: Do not attempt to make measurements in fluids
with the SH-1 (dual needle) or RK-1 sensor.

One motivation behind allowing power mode configuration is to allow
the TR-1 and SH-1 sensors to make better measurements in frozen
materials where the decreased heat input in low power mode is less
likely to cause phase change (melting) of the frozen sample. One
situation where we do recommend a non-default power mode setting
is the measurement of thermal conductivity of snow. In this case,
we recommend using the TR-1 needle to reduce issues with contact
resistance, and we recommend configuring the sensor to low power
mode to reduce issues with melting.
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2.5 Installing the Sensors

We designed all four KD2 Pro sensors for ease of installation and
use. Please observe the following considerations when installing the
sensors.

• Insert the needle all the way into the material.

• We included a drill bit for the TR-1 sensor that you can use
to drill a pilot hole in material such as wood or hard soil. You
should use the optional RK-1 sensor for rock (or cured con-
crete). Drill a 5

32” or 4 mm hole with a hammer drill and fill
it with thermal grease to provide optimal contact between the
RK-1 sensor and rock or concrete.

• For the dual-needle sensor, the needles must remain parallel
to each other during insertion to make an accurate reading.
Therefore, take care in tough material, which can splay the
prongs and adversely affect readings. Use the provided red tab
with pilot holes to make sure that the needles have the correct
spacing. Sample size depends on your sample material thermal
properties, contact Decagon for assistance in taking difficult
measurements.

• Because the sensors give off a heat pulse, you must allow a
minimum of 1.5 cm of material parallel to the sensor in all di-
rections, or errors occur.

Note: Bending the needles can damage the sensor beyond re-
pair. If the needle becomes bent, do not bend it back; contact
Decagon for a replacement.

• Good thermal contact between the sensors and the measured
medium is critical for accurate measurements if you drill a hole
for sensor insertion. Make sure that the sensor fits tightly into
the hole. Use the thermal grease included with your KD2 Pro
to improve contact in drilled holes or grainy samples.
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3 The Menus

The KD2 Pro features four main menus: The Main, Data, Config,
and Auto. These menus access the KD2 Pro features, and we de-
signed them for ease of use. This section provides a more detailed
description of each menu.

3.1 The Main Menu

The Main menu is where you take measurements. The following
labeled screen shot shows a breakdown of a typical reading return.

What You See:

1. The thermal property reading and the currently selected unit.
The letter to the left of the reading indicates the type of read-
ing.

K = thermal conductivity
C = specific heat capacity
D = thermal diffusivity
ρ = thermal resistivity

Note: When the spinner icon is visible, press the arrow keys
to scroll through. The different thermal property readouts for
the current sensor.

2. This icon shows the connected sensor type.

17
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3. Indicator for high power mode (HPM) or low power mode
(LPM).

4. The currently connected sensor name.

5. The measurement temperature in ◦C or ◦F.

6. Indicates the read time selected for current sensor.

7. Indicates that a reading is in progress.

8. Progress bar that displays elapsed time.

The purpose of the Main menu is to take measurements. Section 5
provides more detailed information on how to take a measurement.
After taking a measurement, there are three measured values on the
left side of the screen.

Thermal Properties Reading - The calculated thermal measure-
ment and units reported.

Starting Temperature - The initial temperature prior to any
heating or cooling.

Err Value - The err value is the relative error for the reading. It
is a measure of how well the model fits the data (the Theory
section of this manual describes the model that is fit to the
data). If the model fits the data perfectly, then err = 0.0000.
The purpose of displaying this reading is to indicate possible
problems with the data. A good data set gives err values below
0.0100, except at very low thermal conductivity (e.g. insulation
materials). If the err value is unusually large, discard the data,
wait fifteen minutes and take another reading. Review section
7.3 for a detailed explanation of the err value.

On the right side of the screen are three save options:

Save - Save your reading as is;

Annotate - Attach a sample ID to your reading;

Discard - Cancel the current reading and return to the Main screen.

Note: If the data memory is full or the sample temperature is unsta-
ble during a reading, an error message displays at the bottom of the

18
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screen. If this should happen, you may still take readings but you are
unable to save them to the KD2 Pro.

Annotating Readings: When you select the “Annotate” option,
you see a series of lines with an arrow above and below the first po-
sition. Use the up and down arrow keys to select a letter or number
and press Enter to move to the next character. If you have anno-
tated a previous reading, the old annotation remains to be modified
or deleted.

Repeat the selection process until you reach the last character. When
finished, simply continue to press Enter until you reach the end of
the row. Holding Enter or Escape allows you to scroll left and right
through the Sample ID quickly.

3.2 The Data Menu

The Data Menu allows you to view stored data, download data to a
computer, and erase the data from your KD2 Pro. It also displays
how many readings have been recorded out of the total 4,095 available
slots.

19
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View

The View option allows you to view all data currently stored on
your KD2 Pro. Press Enter to access the readings, and use the ar-
row keys to scroll through them. By pressing Enter a second time,
you can see more detail about a reading.

Download

The Download feature sends the data saved in the KD2 Pro to your
computer. You have two download options:

Download All - This downloads the temperature readings as well as
the measured thermal properties.

Download Summary - This downloads just the measured thermal
properties.

Note: Your KD2 Pro comes with a USB-to-Serial cable for interfac-
ing with Microsoft Windows. The Utility makes downloading data to
your computer very easy.

If you are unable to use the KD2 Pro Utility, you can use the terminal
software to transfer the data from your KD2 Pro to your computer.
The following steps should apply to most terminal software programs.

1. Configure your terminal software with the following settings.

• 9600 baud

20
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• 8 data bits, 1 stop bit, no parity

• No software or hardware flow control

• Append line feeds to incoming line ends

• Echo typed characters locally.

2. Connect your KD2 Pro to an available USB port on your com-
puter using the included USB-to-Serial cable.

3. Set your terminal software to capture received data if you want
to save the data.

Erase

This erases all stored data on your KD2 Pro.

Caution: This feature completely erases all data on your
KD2 Pro, and once activated, it cannot be undone.

Follow steps 1 through 3 to erase data.

1. Press Enter to select Erase. The screen “Erase all stored data?”
appears.

2. Press Enter again to erase the memory or Escape if you decide
not to continue. “Erasing...” displays as the device deletes,
which usually takes about six seconds.

3. When this is complete, the controller returns to the Data Menu.

3.3 The Configuration Menu

The Configuration Menu allows you to change system settings and
view information about your KD2 Pro. A battery icon here also
displays the remaining percentage of battery power. There are seven
main customizable features of the “Config” menu: Date, Time, Units,
Read Time, Power Mode, Contrast and the About feature.
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Date

Follow steps 1 through 5 to change the current date.

1. Press Enter to select the date display.

2. The date appears in the center of the screen in day/month/year
format. A pair of arrows are present above and below the first
number.

3. Use the up and down arrow keys to change this number.

4. Press Enter to move to the next item, and repeat step #3. If
you need to return to the previous number, press Escape.

5. When you have finished changing the last number, press Enter
to return to the Configuration Menu.

Time
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Press Enter to select the Time display and follow the same pro-
cedures as setting the date.

Units

You can choose to represent measurement data in either SI or English
units. Press Enter to select an option.

Table 3: SI and English Unit Equivalents

Thermal Thermal Volumetric Thermal

Conductivity Resistivity Specific Heat Diffusivity

(K) (ρ) (◦C) (D)

SI W
(m∗K)

◦C∗cm
W

MJ
(m3∗K)

mm2

s

English BTU
hr∗ft∗◦F

hr∗ft∗◦F
BTU

BTU
◦F∗ft3

ft2

hr

Note: Readings in watts per meters Celsius(Wm ∗◦C) are the same as
readings in watts per meters Kelvin (Wm ∗K), as Celsius and Kelvin
degrees are on the same temperature scale.

Read Time

Allows you to change the read time duration for each sensor type.
To change the read time select the sensor, press Enter, and scroll
through the read time options. Press Esc or Menu to accept the
changes and exit the Power Mode menu. For information on which
read time to use refer to Section 2.
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Power Mode

Allows you to change the power mode each sensor type uses. Do
not change the power mode from the default settings unless you are
an expert operator and are making a specialized measurement. To
change the power mode, select the sensor and press enter to toggle
between high and low power mode. Press Esc or Menu to accept the
changes and exit the Power Mode menu. For more information on
situations where you might want to change from the default power
mode, see the Power Mode portion of Section 2.4.

Contrast

Allows you to change the screen contrast level. Press Enter and
follow the on-screen instructions to modify the contrast.
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About

Displays the serial number and firmware version of your KD2 Pro.

3.4 The Auto Mode Tab

The Auto Mode allows you to set up the KD2 Pro to take readings
automatically. You can select a measurement time in intervals of 15
minutes. The KD2 Pro takes the reading at the selected interval, in
the currently selected units from the Main menu, and begins as soon
as you select this option.

Note: Should the KD2 Pro data memory ever become full (4,095
readings), you may still take readings, but you cannot save them un-
til you erase the stored readings.
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Reading Return Screen Shot Labels

1. Final measurement displayed in the selected units.

2. Icon showing connected sensor type.

3. Indicator for high power mode (HPM) or low power mode
(LPM).

4. Currently connected sensor type.

5. Measurement temperature in ◦C or ◦F.

6. Indicates the selected read time.

7. Set the Measurement intervalusing the up and down arrows
when an hour glass is on the screen.

8. Hourglass icon indicating that time is elapsing until the next
measurement.

9. Number of readings taken.

10. The err value of your data (see description of err value in the
“Main menu” portion of this section for more details).

Note: The KD2 Pro Utility gives you more options to control how
Auto Mode operates, including different time intervals, delayed start
times, and others.
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4 The KD2 Pro Utility

Figure 2: KD2 Pro Utility Main Screen

The KD2 Pro Utility is a program designed specifically for interfacing
with the KD2 Pro. Use this program to download measurement
data to your computer, erase measurement data stored in the KD2
Pro, set the date and time, configure the KD2 Pro to take readings
automatically, and see information about your KD2 Pro.

4.1 System Requirements

Your computer must meet several minimum system requirements to
use the KD2 Pro Utility.

• Microsoft Windows 98 or NT 4 (SP 5) or better

• Intel Pentium Pro or better processor
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• One available USB or serial port port (most models of USB-
to-serial adapters supported)

• Microsoft Excel 97 or better (for saving data as .xls files)

4.2 Installation

You can install the KD2 Pro Utility using the included USB drive
(found in the inside cover of the KD2 Pro Operator’s Manual). You
may also download and install the latest version of the Utility in the
Support section of the online KD2 Product page at www.decagon.com
/thermal.

The KD2 Pro Utility features four main menus, the File, Edit, Ac-
tions, and Help menus. These allow you to change program settings,
as well as settings on the KD2 Pro.

4.3 KD2 Pro Utility Menus

File Menu

Download Summary Data: Using this menu option or the down-
load button on the Main screen allows the user to download all data
except heating and cooling cycle temperature readings.

Download All Data: This allows for the download of all data,
including heating and cooling cycle temperature data stored on the
KD2 Pro.

Downloading Data:

This copies all saved measurement data on the KD2 Pro to your
computer. Follow steps 1 through 5 to download all measurements
on the KD2 Pro to your computer.

1. Make sure the USB-to-Serial cable connects to the KD2 Pro
and to a USB port on your computer.

2. Open the KD2 Pro Utility.
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3. If the correct port is not automatically chosen, select the appro-
priate serial communication (COM) port from the “Use com-
puter communication port” control on the Main screen.

4. Click the “Download” button in the lower right-hand corner to
download all summary day. You can also go to the File menu,
and select one of two options:

(a) Download Summary Data - Downloads and summarizes
the data readings, but does not display per-second read-
ings.

(b) Download All Data - Downloads all data currently stored
in the KD2 Pro memory. It displays complete data for
each measurement, including per-second readings.

If you encounter an error message after clicking this button,
please refer to Section 6 Troubleshooting section for instruc-
tions. Name your data file, select where it saves to, and in
what format. You may choose from four file formats.

(a) Microsoft Excel Workbook (*.xls)

(b) Comma delimited (*.csv)

(c) Tab delimited (*.txt)

(d) Raw data (also *.txt)

5. Click “Save” to download your data to the specified location.
The progress bar shows the status of the download process.(Figure
3)
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Figure 3: KD2 Pro Downloading Data

Note: You can cancel a download in progress using the cancel button.
If you cancel, it does not save any downloaded data.

Erase Data Removes all data from the KD2 Pro. This is an ir-
reversable function.

Edit Menu

The Edit menu contains the cut, copy, paste, preferences, and select
all features. The important feature here is the Preferences window.
The Preferences window allows you to modify program and commu-
nication settings for the KD2 Pro. The Preferences window has three
tabs: the Data File, Communications, and Application tabs.
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4.3.1 Preferences Window

Data File Tab

Figure 4: Preferences Menu – Data File Tab

The data file has several features.

Measurement Units: Selecting “Use KD2 Pro Settings,” saves
all downloading measurement data in the units used on the KD2
Pro. You can also choose to override the settings in the KD2 Pro
and save your measurement data using either SI (metric) or English
units.

Column Headers: This option allows you to include or exclude
column headers (i.e. “Measurement Time,” “Sample ID,” etc.) for
downloaded data. The “Raw Data” files do not have headers.

Date/Time Format: Sets the date and time format for down-
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loaded data files. You can select to use “Windows Regional and
Language Options,” 24-hour time, or 12-hour time.

Communications Tab

Figure 5: Preferences Menu – Communications Tab

Command Retries: If you encounter difficulty communicating
with your KD2 Pro, you can set the number of times the computer
should automatically try sending communications commands again
(up to ten times).

Maximum Baud Rate: You can set the maximum baud rate for
talking to your KD2 Pro. Choose a lower baud rate if you are not
getting reliable communications from your device.

Force Find all Communications Ports: This detects all COM
ports on your computer, and should be used if your USB-to-Serial
adapter does not appear in the “Use computer communication port”
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control.

Application Tab

Figure 6: Preferences Menu – Application Tab

Automatic Internet Version Checks: If you select this option,
the KD2 Pro Utility automaticallys check for a newer version using
Decagon’s Internet version check engine. It notifies you when a newer
version is available when your computer is connected to the Internet.
You can turn off the automatic check by unchecking this option. You
can manually check for updates anytime using the “Check for Utility
Updates...” option in the Help menu.

Automatic Clock Synchronization: Automatically sets the KD2
Pro time to your computer time, when you are connected to it. (See
instructions for setting this manually later in section 4.)
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Actions Menu

Set KD2 Pro Date/Time: See “Setting Date and Time” por-
tion of this section for more information on setting the date and time.

Configure Auto Mode: Allows you customize how the KD2 Pro
operates in Auto mode. You can program specific time intervals and
start times in this menu. See “Setting the Auto Mode” in Section 4
for more information.

View KD2 Pro Information: Displays information about your
KD2 Pro. See “Viewing KD2 Pro Information” section for more in-
formation.

Help Menu

The Help menu allows accesses the KD2 Pro Utility help file, which
provides detailed information on how to use the program.

Send Feedback to Decagon: This menu item helps you send
product feedback, bug reports, or feature requests to Decagon. Your
computer must be connected to the Internet for this feature to work.
See Appendix B for more information.

Check for Utility Updates: If you select this function when con-
nected to the Internet, the KD2 Pro Utility checks for a newer ver-
sion using Decagon’s Internet version check engine. It notifies you if
a newer version is available.

Check for Firmware Updates: If you select this function when
connected to the Internet and your KD2 Pro, the KD2 Pro Utility
checks for updates for the KD2 Pro operating system (firmware).

About KD2 Pro Utility: Displays the current program version
and Decagon contact information.
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4.4 Organizing Saved Data

Measurement Data from the KD2 Pro saves in the same basic struc-
ture regardless of the file format chosen. You can choose to download
summary data or all measurement data. A description of each type
of download follows.

Clicking the Download button or choosing “Download Summary
Data” from the File menu creates a file with the following columns:

• Measurement Time - Shows date and time of the reading.

• Sensor - The model number of the sensor used for this reading.

• K (Thermal Conductivity) - as W
(m∗k) or BTU

(hr∗ft∗◦F ) .

• ρ (Thermal Resistivity) - as ◦C ∗ cm
W or hr∗ft∗◦F

BTU .

• ◦C (Specific Heat) - as MJ
(m3∗K)

or BTU
(◦F∗ft3) .

• D (Thermal Diffusivity) - as mm2

s or ft2

hr (dual-needle sensors
only).

Note: Columns for Specific Heat and Thermal Diffusivity are
only included when the downloaded data contains measurements
made with SH-1.

• Err- Quality of fit of the data to the KD2 Pro theoretical model.

• Temp(0) - Initial temperature of the sample as ◦C or ◦F.

• Sample ID - If saved with the measurement.

• Read Time - as minutes from the start of heating. The interval
between readings is also Read Time (in sec).

• Power Mode - Power mode selected during measurement.

Choosing “Download All Data” from the File menu creates a file with
all the data included in the summary file (listed above) and adds the
following columns:
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• Power - as W
m

• Current - as amps

The next 60 columns in the row hold the individual temperature
reading the KD2 Pro uses to calculate the thermal properties of the
sample. The data displays in either ◦C or ◦F.

The time interval between the 60 individual temperature readings
is scaled according to the read time selected. For instance, if a one
minute read time has been selected, each of the 60 temperature read-
ings are at one second intervals, while a five minute read time pro-
duces 60 temperature readings at five second intervals, etc.

The KD2 Pro Utility formats measurement dates according to the
Windows Local settings found in the Control Panel under “Regional
and Language Options” (“Regional Settings” in Windows 98). You
can override this by going to the Preferences Menu > Data File tab,
and selecting an option under “Date/Time Format.” You can set this
value to day/month/ year format, using a 12- or 24-hour clock. (The
Preferences Menu is explained in more detail later in this section.)

4.5 Erasing Your Data

This erases all data stored on your KD2 Pro.

Caution: Once you activate this feature, all data is perma-
nently deleted from the KD2 Pro and cannot be recovered

Follow steps 1 through 4 to erase the data.

1. Make sure that the USB-to-Serial cable connects securely to
the KD2 Pro, and to a USB port on your computer.

2. If the correct port is not automatically chosen, select the appro-
priate serial communication (COM) port from the “Use com-
puter communication port” control on the Main screen.

3. Click “Erase,” in the lower left hand corner, or select “Erase
Data...” from the File menu.
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Note: If you encounter an error message, please refer to the
Troubleshooting section for instructions.

4. A progress bar shows the status of the erase process.

4.6 Setting the Date and Time

You can set the KD2 Pro date and time by selecting “Set KD2 Pro
Date/Time...” from the Actions Menu. This automatically syncs the
KD2 Pro date and time to your computer time.

4.7 Setting the Auto Mode

The Auto mode of the KD2 Pro allows you to perform automatic
and autonomous measurements at specified time intervals. The KD2
Pro has pre-set measurement intervals to select for this mode, but
you can better customize how the KD2 Pro operates in Auto mode
using the KD2 Pro Utility software. For example, you can select
specific measurement intervals, delayed start times, and the number
of measurements from this menu.

Follow steps 1 through 3 to configure Auto Mode with the KD2
Pro Utility.

1. If the correct port is not automatically chosen, select the appro-
priate serial communication (COM) port from the “Use com-
puter communication port” control on the Main screen.

2. Choose “Configure Auto Mode...” from the Actions Menu. The
Configure Auto Mode screen appears.
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Figure 7: Actions Menu Screen

3. Choose values for Measurement Interval, Start Time, and Num-
ber of Measurements. Each of these values is explained below.

Measurement Interval: The Measurement Interval is the
time interval (in minutes) that the KD2 Pro waits between
measurements. The instrument must have a minimum of 15
minutes between measurements to allow for thermal gradients
to dissipate. Therefore, you can select any number over 15
minutes, up to 1,440 minutes (24 hours).

Start Time: Allows you to select when the auto measure-
ment begins. Choose start times ranging from “Start Now”
to delaying the start for 24 hours. If you select “Start Now,”
make sure you have the needle in the sample and thermally
equilibrate because you have only 30 seconds to connect the
thermal properties sensor to the KD2 Pro before the reading
starts.

38



KD2 Pro 4 THE KD2 PRO UTILITY

Number of Measurements: This is the total number of
measurements that you want the KD2 Pro to make while in
Auto Mode. The number is between one and the amount of
available memory. As you change this value, the Experiment
Duration value changes. The KD2 pro stores up to 4,095 read-
ings.

Experiment Duration: This is the total amount of time that
your KD2 Pro operates in Auto Mode, according to your mea-
surement interval and number of measurements selected. This
gives you an idea of how long the total Auto Mode experiment
time takes.

Available Memory: This shows how much memory you have
available for storing measurements. The KD2 Pro Utility pre-
vents you from defining an experiment that could exceed the
amount of available memory. If you reach the limit of mem-
ory storage, the KD2 Pro stops taking measurements in Auto
Mode.

KD2 Pro Date/Time: This shows the current time in your
KD2 Pro. If the time is not correct, click the Cancel button,
then choose “Set KD2 Pro Date/Time...” from the Actions
Menu.

4. Click on the Start button. The KD2 Pro Utility then sends
your settings to the KD2 Pro.

5. Unplug the cable from the KD2 Pro, then connect the desired
thermal properties sensor to the instrument. Your KD2 Pro
is now ready to make autonomous measurements as you have
programmed it.

Viewing KD2 Pro Information

Choose “View KD2 Pro Information...” from the Actions Menu to
see information about your KD2 Pro.
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Figure 8: KD2 Pro Information Screen

This displays useful info about your KD2 Pro, including its serial
number, firmware version and status, battery status, the number of
currently stored measurements, and current data and time in the
KD2 Pro operating system.
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5 Taking Measurements

Making thermal measurements with the KD2 Pro. Section 5 helps
you get accurate measurements.

Note: If the temperature of the sample is different from the tem-
perature of the needle, the needle must equilibrate to the surrounding
temperature before beginning a reading.

1. Attach appropriate sensor then turn on the KD2 Pro.

2. Properly insert the needle into the material to be measured.
(See “Installing the sensors” in this section for instructions.)

3. When the KD2 Pro turns on, you should be in the Main menu.
(Figure 2) If not, press the Menu key until you arrive there.
Press Enter to begin the measurement.

4. An icon appears on the left and right side of the screen. The
icon at left indicates the type of sensor connected. The cir-
cular icon indicates that a reading is in process. It changes
to a thermometer icon to indicate whether the measurement is
currently in heating or cooling mode; when the thermometer
is rising, heat is applied to the needle, and when it is falling,
heat is off. A progress bar at the bottom of the screen shows
the elapsed time.

5. When the reading is complete, the results display as follows.
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Note: It is important to allow about fifteen minutes for equilibration
between readings, even if the sensor is left in the same location.

If multiple measurements of a sample are made too rapidly in suc-
cession, the sample and needle temperature do not have had enough
time to equilibrate from the previous reading, and the resulting mea-
surement is inaccurate. For best results, the sample should be as
close to equilibrium as possible. You can provide a good environ-
ment for equilibration by placing the KD2 Pro sensor and sample in
an isothermal chamber or Styrofoam box.

5.1 General Best Practices

The quality of the measurements you get with the KD2 Pro can be
strongly affected by your measurement practices. The following sug-
gestions can help you to recognize and avoid pitfalls in data collection
so that you obtain the most accurate data possible.

1. Keep the temperature of the sample as constant as possible
during the measurement. The measurement is made by heat-
ing a needle that is placed in the sample and monitoring the
temperature of the needle. In the case of the SH-1 sensor, one
needle heats while the other one monitors. The heat input is
made as small as possible to avoid thermally driven redistribu-
tion of moisture in the sample. The temperature change from
heating may therefore be only a few tenths of a degree.

f Sample temperature changes during the measurement period
degrade the data and make it difficult for the inverse calcula-
tion to find the correct values for the thermal properties. The
algorithms in the KD2 Pro are several orders of magnitude less
sensitive to these errors than the conventional approach (plot-
ting temperature vs. log time during heating and looking for a
linear portion of the graph) but there can still be errors if the
temperature changes too rapidly during a measurement. To
minimize these sources of error:

(a) First, always allow about 15 minutes for samples and nee-
dles to equilibrate with the ambient temperature before
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taking measurements.

(b) Allow around 15 minutes between readings for tempera-
tures to equilibrate.

(c) If measurements are made in a temperature chamber or
water bath, make sure the sample temperature stays rela-
tively constant before the measurement starts. Measure-
ments made while a sample taken from an oven and cool-
ing to room temperature can show significant errors if the
cool rate is too fast. Measurements made while the sampe
is undergoing heating or cooling return large errors and
are less accurate than samples with a stable temperature

(d) When measuring thermal properties in the field, allow fif-
teen minutes or so after sensor insertion for temperature
equilibration.

2. Minimize contact resistance. In granular materials, or in solids
where a hole has been drilled to accommodate the sensor, there
is an additional thermal resistance between the heated sensor
and the material into which the sensor is inserted. This ex-
tra resistance is called contact resistance, and it decreases the
thermal conductivity value registered by the sensor. This ef-
fect can be minimized by applying thermal grease to the sensor
prior to inserting it as described in the Decagon Application
Note “Reducing Contact Resistance Errors in KD2 Thermal
Properties Measurements” located in the Support section of
https://www.decagon.com/thermal. When you drill a hole for
the sensor, make sure the sensor fits in the hole is as tight as
possible. Inject thermal grease onto the needle as needed to
improve contact.

Long read times also decrease the effect of contact resistance.
If you are measuring a sample that might give errors from con-
tact resistance, increase the read time from the default to the
maximum (10 minutes) for most accurate results.

Finally, the TR-1 works best for dry granular materials and
powders that have large contact resistance, try to always use
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the TR-1 sensor in these types of materials.

3. Do not bend the needles. Needle spacing on the SH-1 sensor
is critical for accurate measurements. A 1% change in needle
spacing results in a 2% error in measurement of diffusivity and
specific heat. A guide is provided for maintaining proper needle
spacing during insertion of the sensor into a sample. The Delrin
verification block included with your system shows the correct
sensor spacing. If a needle is slightly bent, it can be carefully
straightened until the tip spacing matches the hole spacing in
the calibration block.

5.2 Measurements in Concrete or Rock

The best method of using the KD2 Pro for measurements in concrete
or Fluidized Thermal BackfillTMis to mold pilot holes in wet concrete
using the pilot pins furnished with your KD2 Pro. Follow these four
steps to install the pilot pin.

1. Coat pilot pin with thermal grease or Vaseline.

2. Install pin at least 10 cm deep while concrete is wet. Do not
bury the pin or it becomes hard to grip for removal.

3. Remove pin when concrete dries.

4. Coat the TR-1 sensor with thermal grease, insert sensor into
the cast hole and begin to take readings.

If you need to take measurements in rock samples or cured concrete,
use the optional RK-1 sensor. The RK-1 sensor kit includes a “5/32”
rotary hammer bit to drill pilot holes that accommodate the RK-1
sensor. (4 mm rotary hammer bits are also acceptable). After drilling
the holes, be sure to clean the dust and drill cuttings from the rotary
hammer hole using a swab or compressed air before inserting the RK-
1 sensor. It is also necessary to apply a liberal coat of the thermal
grease on the needle to ensure good thermal contact between the
RK-1 sensor and the test material.
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5.3 Measurements in Insulation

KS-1 Insulation measurements are best taken using a ten minute read
time. The long read time minimizes contact resistance errors, and the
low heat of the KS-1 needle reduces free convection errors. Always
drill a hole in foam insulation for the sensor. Manually pushing in the
needle can cause the insulation to bunch in front of and around the
needle resulting in a poor fit and a consequently a faulty reading. In
fiber type insulation materials, assure that the insulating materials
are not unduly disturbed by the needle insertion. (i.e. pushed in
front of the needle tip). Do not allow the sensor to move during the
measurement.

5.4 Measurements in Liquids

We designed the KS-1 sensor to measure thermal conductivity and
resistivity of liquid samples. However, measuring thermal properties
of liquids is difficult and great care must be taken to obtain accu-
rate and repeatable results. For an accurate measurement of thermal
properties of a liquid sample, the sample must be absolutely still in
relation to the KS-1 sensor. Convection, or bulk movement of the
sample, causes errors in the thermal properties measurement. Er-
ror from convective heat exchange is often very large, rendering the
thermal properties measurement useless.

Note: We did not design the TR-1 and SH-1 sensors for thermal
properties measurement in liquids. They do not return accurate re-
sults in those materials.

Convective heat exchange in fluids can be broken down into two cat-
egories: forced and free convection. Forced convection occurs when
the fluid is agitated or mixed by mechanical forces. Free convection
may occur when a body of higher or lower temperature is present in
a fluid. The temperature difference between the body and fluid cre-
ates density gradients in the fluid, and these density gradients cause
the fluid to mix. From a practical standpoint certain steps can be
taken to minimize both forced and free convective heat exchange.
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To eliminate forced convection, the fluid sample and the sensor must
be absolutely still during the measurement. Even minute vibrations
in the sample are often enough to compromise the thermal proper-
ties measurement. Some common sources of vibrations found in the
laboratory that have been shown to affect thermal properties mea-
surement in liquids and must be avoided include:

• HVAC (Heating, Ventilating, and Air Conditioning) systems

• Computer fans that are near the measurement apparatus

• People moving around the lab

• Other laboratory equipment

If sources of vibration are present in laboratory, it may be necessary
to place the sample on a vibration isolation table to prevent errors
from convection. Another common strategy is to configure the KD2
Pro in auto mode and make measurements overnight after turning
off the HVAC system and any other lab equipment that might cause
vibrations.

The KD2 Pro KS-1 sensor is specially designed to add a very small
amount of heat to the sample during measurement and thereby min-
imize problems with free convection. In high viscosity liquids (e.g.
oils, glycerin), free convection is generally not an issue. However, in
low viscosity liquids like water or aqueous solutions, there are several
important tips to aid you in obtaining accurate measurements.

• When dealing with low viscosity liquid samples, the duration
of the read time should be as small as possible to minimize the
amount of heat added to the sample.

• The default read time for the KS-1 sensor is one minute. If you
are measuring in low viscosity liquids, use this read time.

• In liquid samples, the KS-1 sensor needle should be oriented
vertically during the measurement to help prevent free convec-
tion.

• Never use the KS-1 sensor in high power mode in liquids. The
sensor must be configured in low power mode to prevent free
convection.
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5.5 Liquid Sample Temperature Control

Often it is desirable to control the temperature of the liquid sam-
ple above or below ambient temperature during thermal properties
measurement. It is important that the act of heating or cooling the
sample does not cause forced or free convection as mentioned above.
There are several things that should be avoided when measuring ther-
mal properties of heated or cooled samples. Cautions:

Do not heat the sample from the bottom (e.g. on a hot
plate). The temperature gradient from the heating causes
free convection.

Do not make measurements in a conventional refrigerator
or freezer. Conventional cooling devices have very large
cyclical temperature cycles which can cause excessive sam-
ple temperature drift and poor measurements. Vibrations
from the compressor also causes forced convection in the
sample.

Do not measure the thermal properties of the sample while
it is in a circulating water bath. The vibrations from the wa-
ter bath pump and from the circulating water causes forced
convection in the sample.

Controlling Temperature

Several researchers who use the KD2 Pro with liquid samples sug-
gest the following three steps as the best method for controlling the
temperature of liquid samples.

1. Heat or cool the sample (with sensor inserted) in a water bath.

2. Once the sample temperature has equilibrated to the desired
water bath temperature, turn the water bath off.

3. Allow enough time for the water bath to become absolutely
still, and make the measurement.

Note: Experimental results from researchers have shown that the
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KD2 Pro KS-1 sensor can make accurate measurements in water
and aqueous solutions up to about 50 ◦C. Above this temperature, the
viscosity of the water becomes too low and free convection begins to
affect the measurement.

For a more in-depth discussion of measuring thermal properties of
liquids, download the Application Note or watch the video on this at
www.decagon.com/thermal under the Support tab.
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6 Maintenance and Troubleshooting

Although Decagon built the KD2 Pro according to the highest quality
standards, you must practice proper care and maintenance to ensure
continuing operation.

6.1 Cleaning and Caring for the Sensors

The sensors are stainless steel, so they are easy to clean, though some
materials corrode stainless steel. Be sure to carefully clean the needle
after removal from sample materials. When they need cleaning, just
wipe them with a damp cloth. Take care never to bend or move
the needles. If the needle becomes bent, it is most likely broken
and requires testing and replacement. Contact Decagon to see if a
replacement sensor is necessary.

6.2 Changing the Batteries

Although we designed the KD2 Pro to provide an excellent battery
lifespan, the batteries eventually requires changing. When this hap-
pens, a low-battery indicator appears in the upper left hand corner
of the screen. The KD2 Pro requires four alkaline “AA” batteries.
Follow steps 1 through 4 to change the batteries.

1. Turn over the KD2 Pro and locate the battery cover.

2. Place your thumb on the grooves and pull away from the con-
troller to loosen the cover.

3. Remove the old batteries and insert new ones. Be sure to orient
the fresh batteries according to the polarity marks shown in the
case.

4. Update the time and date either in the Config menu of the
KD2 Pro, or by using the KD2 Pro Utility.
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6.3 Verifying Sensor Performance

The KD2 Pro ships with three standard materials you can use to ver-
ify that the sensors are operating according to specifications. These
three materials are a clear vial of glycerin (glycerol) for the KS-1 Sen-
sor, a white plastic cylinder for the SH-1 needle sensor, and a TR-1
Verification Standard for the TR-1 and RK-1 single needle sensors.

Use the glycerol to verify KS-1 Sensor performance. The cap of
the vial has a septum that allows direct insertion of the needle into
the vial for verification.

Note: After repeated use the septum may begin to leak. We pro-
vide replacement septums with your instrument. To replace simply
remove the cap, press the old septum out and replace with a new one.

To conduct a performance verification, insert the needle fully into
the glycerol. Orient the needle vertically and turn the vial of glyc-
erol upside-down on top of the needle. Holding the vial upside down
ensures that any bubbles in the glycerol float to the top away from
the needle. Center the needle in the vial, without touching any side
of the vial. Before taking a measurement in the glycerol, make sure
that the system is not undergoing rapid temperature drift. Even the
heat from holding the vial in your hand for a few seconds, or the cool-
ing from direct air conditioning flow can decrease the accuracy of the
measurement. (Section 5.4 details the best practices for measuring
liquids.) It is best to place the needle and vial in an isothermal en-
vironment (e.g. insulated chamber or cooler), and allow 15 minutes
of equilibration time before taking the measurement. The thermal
conductivity of the glycerol is 0.285 W

(m∗K) at 20 ◦C.

Use the two-hole Delrin block to verify the performance of the dual-
needle (SH-1) sensor. Fully insert the SH-1 sensor into the pre-drilled
holes in the Delrin and allow it to equilibrate for at least 15 minutes
before taking the measurement. Make sure that the system is not
undergoing rapid temperature drift. Slight temperature differences
from sources like body heat or AC can decrease the accuracy of the
measurement. It is best to place the needle and block in an isother-
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mal environment (e.g. insulated chamber or cooler), and allow 15
minutes of equilibration time before taking the measurement. The
Delrin blocks have slightly different thermal conductivities from lot
to lot, so we record the correct values for K, C, and D for your
individual Delrin block are recorded on your Certificate of Quality
Assurance. Your readings should be within 10% of the values on the
certificate

Verification for the TR-1 and optional RK-1 is similar to that for
the SH-1. Place the needle in the block, wait fifteen minutes, taking
care to minimize temperature disturbances, and then take a reading.
The reading of the value recorded on your Certificate of Quality As-
surance be within 10%.

At the request of multiple KD2 Pro operators, we have character-
ized the temperature dependence of the thermal conductivity of the
TR-1 and RK-1 verification cylinders. We collected measurements
on three black plastic cylinders from different lots of material over
the temperature range of −20 to 60 ◦C (Figure 9). We found little
temperature dependence on any of the samples with maximum dif-
ferences over the −20 to 60 ◦C range. The difference is never greater
than 0.004 W

mK (∼1%). Figure 9 shows a graphical representation of
these values.

Figure 9: Thermal Conductivity as a Function of Temperature.
Error bars represent ±1 standard deviation in five replicated

measurements.
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6.4 Troubleshooting KD2 Pro

If you encounter problems with your KD2 Pro, refer to the following
items to see if they resolve your problem.

1. PROBLEM:
I am getting poor or inconsistent readings.

SOLUTION:

Conduct a verification of the sensor to ensure it is operating within
specifications. Refer to Section 5 for measurement procedures and
guidelines.

2. PROBLEM:
The KD2 Pro says it does not recognize the connected sensor.

SOLUTION:

Make sure the connection between the sensor and the KD2 Pro is
secure, and that none of the connector pins are bent or broken off.
If the KD2 Pro still fails to recognize the sensor, the sensor may be
malfunctioning. Contact Decagon for more assistance.

6.5 Troubleshooting KD2 Pro Utility Software

The following descriptions should help you if you encounter any dif-
ficulty using the KD2 Pro Utility.

1. PROBLEM:
The KD2 Pro Utility tells me another application is using the COM
port, but I do not think any other programs are running.

SOLUTION

Some PDA synchronization software monitors serial communication
ports. Disable Microsoft’s ActiveSync or Palm’s HotSync system
software while using the serial port with the KD2 Pro Utility.
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2. PROBLEM:
My USB-to-Serial adapter is not showing in the communication port
picker.

SOLUTION

Enable “Force find all Communication Ports” in Preferences by go-
ing to the Edit > Preferences, and then selecting the Communication
tab. Enable the check box at the bottom of the screen. Enabling
this option may find other serial ports that are not available for use
by the KD2 Pro Utility (for example, modems installed in your com-
puter).

3. PROBLEM:
Downloading data stops in the middle with an error message saying
the Utility lost connection with the KD2 Pro.

SOLUTION

A noisy serial connection can disrupt the connection between the
Utility and the KD2 Pro. If this error happens regularly, you can try
setting your baud rate lower or increasing the number of times you
send a command to the KD2 Pro. Choose the Communications tab
in Preferences to alter this setting.

6.6 Service Instructions

If your KD2 Pro should ever require servicing, call Decagon at 509-
332-5599. We ask you for your address, phone number, your KD2 Pro
serial number, and your current firmware version. For non-warranty
repairs, we also ask for a method of payment.

Before shipping your instrument to Decagon, please contact us to
obtain a Request Maintenance Authorization number (RMA). This
allows our repair staff to keep track of your KD2 Pro. Once you have
acquired an RMA, send your KD2 Pro to Decagon.
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Please pack your KD2 Pro carefully. Ship it back in the carrying
case, preferably inside a cardboard box. Ship to:

Decagon Devices Inc.
2365 NE Hopkins Court

Pullman, WA 99163
ATTN: RMA[RMA Number ]

Repair Costs

Decagon repairs manufacturer’s defects and instruments under war-
ranty at no cost. We bill costs for parts, labor, and shipping for
non-warranty repairs,.

54



KD2 Pro 7 KD2 PRO THEORY

7 KD2 Pro Theory

Researchers have used transient line heat source methods to measure
thermal conductivity of porous materials for over 50 years. Typically
a probe for this measurement consists of a needle with a heater and
temperature sensor inside. A current passes through the heater and
the system monitors the temperature of the sensor over time. Analy-
sis of the sensor temperature determines thermal conductivity. More
recently the heater and temperature sensors have been placed in sep-
arate needles. In the dual probe the analysis of the temperature vs
time relationship for the separated probes yields information on dif-
fusivity and heat capacity as well as conductivity.

An ideal sensor has very small diameter and a length perhaps 100
times its diameter. It would be in intimate contact with the sur-
rounding material and would measure the temperature of the mate-
rial during heating and cooling. Ideally, the temperature and com-
position of the material in question would not change during the
measurement.

Real sensors fall short of these ideals in several ways. A sensor small
enough to be ideal would be too fragile for most applications. Mea-
surements in outdoor environments involve changing temperatures;
the ambient temperature generally is not constant. Heating moist,
unsaturated soil causes water to move away from the heat source,
thus altering the water content in the region of measurement, and
the hole made for the probe often disturbs the material around it
causing a contact resistance between the sensor and the material.

It is a challenge to design a sensor that gives accurate measurements
under all conditions. If the sensor is too small it is fragile, and the
contact resistance can be high in dry, porous materials. Large sensors
require a long heating time, but the long heating time drives water
away from the sensor and can cause free convection in liquid samples,
thus altering the reading. A high heating rate makes temperature
changes easier to read and less susceptible to temperature drift er-
rors, but results in water movement out of the measuring region and
free convection in liquids. We recommend long heating times to min-
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imize contact resistance that results in water movement away from
the sensor.

Decagon’s KD2 Pro design attempts to optimize thermal proper-
ties measurements relative to these issues. Our sensors are relatively
large and robust making them easy to use. The KD2 Pro keeps heat-
ing times as short as possible to minimize thermally induced water
movement and lower the time required for a measurement. We also
limit heat input to minimize water movement and free convection.
Use of relatively short heating times and low heating rates requires
high resolution temperature measurements and special algorithms
to measure thermal properties. The KD2 Pro resolves temperature
to ±0.001 ◦C in temperature. It uses special algorithms to analyze
measurements made during a heating and a cooling interval. Algo-
rithms also separate out the effects of the heat pulse from ambient
temperature changes. The KD2 Pro uses two different algorithms,
one for the dual needle sensor and one for the single needle, based
on Carslaw, Jager, and Kluitenberg’s line heat source analysis.8

7.1 Dual Needle Algorithm

Heat is applied to the heated needle for a set heating time, th, and
temperature is measured in the monitoring needle, 6 mm distant
during heating and during the cooling period following heating. The
readings are then processed by subtracting the ambient temperature
at time 0, multiplying by 4π and dividing by the heat per unit length,
q. The resulting data are fit to the following equations using a non-
linear least squares procedure.

T ∗ = b0t+ b1Ei(
b2
t

) (1)

T ∗ = b0t+ b1

{
Ei(

b2
t

) − Ei

[
b2

t− th

]}
(2)

where:

T ∗ =
4π(T − T0)

q
(3)

8Carslaw and Jaeger (1959) and Kluitenberg et al. (1993).
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Here, Ei is the exponential integral,9 and bo, b1 and b2 are the con-
stants to be fit. To is the temperature at the start of the measurement
and q is the heat input. The first equation applies for the first th
seconds, while the heat is on. The second equation applies when
the heat is off. Compute thermal conductivity from Equation 4 and
diffusivity from 5.

k =
1

b1
(4)

D =
r2

4b2
(5)

You can find the conductivity and diffusivity by fitting equation 1
to the transformed data. The correct values of b0, b1 and b2 are the
ones which minimize the sum of squares of error between the equa-
tions and the measurements. Use the Marquardt (1963) non-linear
least squares procedure to find the correct values. This procedure
is susceptible to getting stuck in local minima and failing to find a
global minimum in some problems (the single needle problem is a
perfect example of a bad non-linear least squares problem) but the
dual needle problem typically works well. The KD2 Pro can find the
three model parameters quickly.

7.2 Single Needle Algorithm

Heat is applied to a single needle for a time, th, and temperature is
monitored in that needle during heating and for an additional time
equal to th after heating. Two needle sizes are used; One (the KS-
1) is 1.2 mm diameter and 6 cm long. The other (the TR-1) is 2.4
mm diameter and 10 cm long. The temperature during heating is
computed from equation 6.

T = m0 +m2t+m3 ln t (6)

Where m0 is the ambient temperature during heating (which could
include some offset for contact resistance and the heating element
being adjacent to the temperature sensor inside the needle), m2 is
the rate of background temperature drift, and m3 is the slope of a
line relating temperature rise to logarithm of temperature.

9Abramowitz and Stegun, (1972).
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Equation 7 represents the model during cooling.

T = m1 +m2t+m3ln

[
t

t− th

]
(7)

The thermal conductivity is computed from Equation 8.

k =
q

4πm3
(8)

Since these equations are long-time approximations to the exponen-
tial integral equations (Equation 1), we use only the final 2

3 of the
data collected (ignore early-time data) during heating and cooling.
This approach has several advantages. One is that effects of contact
resistance appear mainly in these earlytime data, so by analyzing
only the later time data the measurement better represents the ther-
mal conductivity of the sample of interest. Another advantage is that
equations 5 and 6 can be solved by linear least squares, giving a solid
and definite result. The same data, subjected to a non-linear least
squares analysis, can give a wide range of results depending on the
starting point of the iteration because the single needle problem is
susceptible to getting stuck in local minima. The linear least squares
computation is also very fast.

7.3 The Error (Err) Value

When heat at a constant rate, q is applied to the KD2 Pro needles,
the temperature response of the sensor over time can be described
by the equation 9.

∆T = − q

4πk
Ei

(
−r2

4Dt

)
(9)

where k is the thermal conductivity of the medium in which the
needle is buried, D is the thermal diffusivity of the medium, r is
the distance between the heater and the sensor where temperature
is measured, and Ei is the exponential integral. The KD2 Pro uses
this equation to model temperature rise in the dual needle sensor,
and uses just the first term of the exponential integral expansion (the
logarithm of time) for the single probe sensors. Values of k and D are
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sought which minimize the difference between model and measured
values of temperature rise. Temperature of the needle is measured,
so ∆T is first computed by subtracting the initial temperature from
all readings. Temperature rise is further scaled by multiplying by 4π
and dividing by q. If we call this new temperature variable T∗, then
we find the values of k and D that minimize the sum of squares of
error.

SSE =
∑

(T ∗
i −M∗

i )2 (10)

where the T ∗
i are the measured values and the M∗

i are values modeled
with Equation 9. Equation 11 shows the standard error of estimate
for the measurements.

Syx =

√
SSE

n
(11)

where n is the number of measurements. The units of Syx aremC/W .
It can be made dimensionless if it is multiplied by the thermal con-
ductivity, k. This dimensionless value gives the error in fitting the
model to data as a value independent of heater current or the ther-
mal conductivity of the medium. The KD2 Pro computes err as in
equation 12.

err = kSyx (12)

It is a dimensionless measure of the goodness of fit of the model to
the data. It can be converted to temperature by dividing by k and
multiplying by q.

Note: The Err term is not a rigorous statistical indicator of mea-
surement quality, but it serves as a qualitative quality indicator.
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8 Reference Materials

Decagon Application Notes

Note: You may find all application notes on our website at www.decagon.com.

“Finding the R Value of Insulation using the KD2”

“Heat and Water Transport in Soil”

“How Large Does my Sample Need to be for Thermal Properties
Measurements?”

“How to Reduce Contact Resistance Errors in Thermal Properties
Measurements”

“KD2 Pro Compliance to ASTM and IEE Standards”

“Methods, Instrumentation, and Standards for Measuring Thermal
Properties in Soil, Rock and Concrete”

“Producing Thermal Dryout Curves for Buried Cable Applications”

“Reducing Contact Resistance Errors in KD2 Thermal Properties
Measurements”

“Simultaneous Thermal Conductivity and Thermal Diffusivity Mea-
surement of Foods”

“The Effect of Soil Thermal Resistivity (RHO) on Underground
Power Cable Installations”

“The KD2 and KD2-Pro Thermal Properties Analyzers vs. ASTM
and IEEE Standards”

“The Science of Grilling Meat”

“Thermal Resistivity of Porous Materials (Soils) Change with Chan-
ges in Density, Water Content, Termperature and Composi-
tion”

“Underground Power Cable Installations: Soil Thermal Resistivity
(13476-00 AN)”

“Using the KD2 Pro to Measure Thermal Properties of Fluids”
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9 Appendix A

9.1 Table of Thermal Units

Table 4: Table of Thermal Units

Measurement SI Unit

English
English

SI

Conversion
Unit

Conversion

Multiplier Multiplier

Heat Joule 0.000948 BTU 1055

Heat Joule 0.239 cal 4.187

Heat Flux W
m2 0.00146 cal

(cm2min) 697
Density

Thermal W
m∗K 0.578 BTU

hr∗ft◦F 1.73
Conductivity

Thermal W
m∗K 6.93 BTU∗in

hr∗ft2∗◦F 0.144
Conductivity

Thermal
cm ∗ ◦C

W
0.0173 ft∗hr∗◦F

BTU
57.8

Resistivity

Thermal
cm ∗ ◦C

W
0.00144 ft2∗hr∗◦F

BTU∗in 693
Resistivity

Specific J
kg∗K 0.000239 BTU

lb∗◦F 4186.8
Heat

Diffusivity mm2

s 0.0388 ft2

hr 25.794

Diffusivity m2

s 0.1076 ft2

s 9.29
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10 Appendix B

10.1 Send Feedback to Decagon

The KD2 Pro Utility Software makes it easy to send feedback, bug
reports, and feature requests to Decagon or your Decagon Distrib-
utor. Choose “Send Feedback to Decagon...” from the Help menu.
This opens the window shown in Figure 10.

Figure 10: Send Feedback to Decagon

63



10 APPENDIX B KD2 Pro

Enter your name, company name, and other contact information.
Tell us what type of feedback you are sending (General Feedback,
Feature Suggestions, Bug Report, or Other). Indicate how you want
us to respond to your feedback (E-mail or Telephone).

Use the description area to give details for your feedback. If you
are reporting a bug, it is very helpful for you to tell us what steps
you took for the bug to happen and any error message you saw. By
default, bug reports also include the software error files.

You can send Decagon a file using this form too. This is useful
for sending data files that you have questions about. If you work
directly with a Decagon representative, put their E-mail address in
the field at the bottom of the form. This sends the contents of the
form to them. Your Decagon representative can follow-up with you
directly.
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11 KD2 Pro CE Compliance

Application of Council Directive: 2004/108/EC and 2011/65/EU

Standards to which conformity is
declared:

EN 61326-1:2013 and

EN 50581:2012

Manufacturer Name: Decagon Devices, Inc.

2365 NE Hopkins CT

Pullman, WA 99163 USA

Type of Equipment: Thermal Properties Meter

Model Number: KD2 Pro

Year of First Manufacture: 2006

This is to certify that the KD2 Pro Thermal Properties Meter, man-
ufactured by Decagon Devices, Inc., a corporation based in Pullman,
WA, USA meets or exceeds the standards for CE compliance as per
the Council Directives noted above. All instruments are built at
the factory at Decagon and pertinent testing documentation is freely
available for verification.
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Measurements
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Memory Capacity, 5
Menus
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Data, 19
Main Menu, 17

Power Mode, 15, 24

Save, 18
Saving Data, 35
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Installation, 16
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Taking a Measurement, 41
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